1 Tekla Structures 2017 release notes.................................................................5
  1.1 Object IDs changed to GUIDs.............................................................................7
  1.2 User interface improvements..............................................................................7
    Saving backup copies of models.........................................................................7
    Making company-level customizations..............................................................7
    More visual copying of object properties.........................................................8
    Improvements in the contextual toolbar..........................................................8
    Switching tooltips on or off.............................................................................11
  1.3 Installation and multi-user server changes...................................................12
    Tekla Warehouse offline content available as .tsep packages........................12
    New version of Tekla Structures multi-user server.......................................12
  1.4 Support for use in IPv4, IPv6 and dual mode networks.................................13
  1.5 Modeling improvements..................................................................................14
    Selecting objects hidden behind other objects.............................................14
    Direct modification improvements...............................................................14
    New snap settings...........................................................................................22
    Bent plate improvements................................................................................23
    Custom inquiry available in side pane.........................................................26
    Improvements in clash checking.....................................................................27
    New command for showing all detailing of a part..........................................28
    Documentation updates for filtering..............................................................28
  1.6 Model dump no longer available...................................................................28
  1.7 Rebar sets - A flexible new way to create reinforcement...............................30
    Rebar sets are easy to modify........................................................................32
    Rebar set properties available in the property pane......................................34
    New settings related to rebar sets..................................................................36
    Rebar sets in drawings..................................................................................36
    Rebar sets in numbering, reports, and Organizer...........................................37
    Limitations.....................................................................................................37
  1.8 New tolerance settings in Rebar shape manager...........................................37
  1.9 Faster synchronization and other Organizer and Task manager improvements.................................................................38
    Faster synchronization in Organizer..............................................................38
    More fluent and faster reporting in Organizer..............................................38
    Use Task manager to show a sequence in the model....................................41
  1.10 Better performance and other drawing improvements..................................42
    More informative opening of drawings..........................................................42
    Improved drawing performance.....................................................................42
    Mark drawings ready for issuing....................................................................43
    Both letters and numbers allowed in section view labels.............................43
    Delete marks of selected parts at one go......................................................44
    New gray drawing line colors.......................................................................45
    Fill available for neighbor parts.....................................................................47
Improved custom grid labels.................................................................................................47
Add images from 2D Library................................................................................................48
Filtering improvements........................................................................................................48
Openings and recesses drawn correctly...............................................................................48
Inch marks now shown after fractions of an inch..............................................................49
Rich text file improvements.................................................................................................49
Select all (Ctrl+A) in drawing texts....................................................................................50
Improved snapshot overlay with color support...................................................................50
AutoDrawings available in Quick Launch............................................................................50
New option to define automatic hatches separately for Precast and CIP.........................51
Improvements in reinforcement dimensions.......................................................................52
Rebars visible in reference models in drawings.................................................................55
New content type option in Rebar mesh view creator.......................................................55
New location for loading drawing presentation and dimensioning plug-ins....................56

1.11 Drawing sketching and snapping improvements.......................................................56
Increased visualization in sketching tools...........................................................................57
More flexibility to cover-up tools.......................................................................................58
Possibility to re-order objects............................................................................................59
Improved Copy with offset...............................................................................................60
Improved snapping in drawings.......................................................................................60
Improved pattern lines......................................................................................................62

1.12 Reference model and base point improvements.........................................................63
Improvements in reference model change detection......................................................63
Improvements in reference model conversion management.........................................66
New macros for selecting converted or corresponding objects.....................................67
Other improvements in reference model handling.......................................................67
Improvements in project base point functionality........................................................68

1.13 IFC export improvements..........................................................................................68

1.14 NC export improvements..........................................................................................69
New option allowing pop-marks for parts welded on site..............................................69
Pop-marks created based on the weld primary and secondary part............................69
Maximum diameter for circular cuts to be drilled.........................................................69

1.15 EliPlan improvements.................................................................................................70

1.16 ToDo notes available in Trimble Connector..............................................................70

1.17 Applications & components catalog and component improvements.......................71
Change the order of groups in the Applications & components catalog.......................71
Concrete components.....................................................................................................72
Documentation updates for custom components............................................................73

1.18 New template attributes...........................................................................................73
New attributes for getting information on marked ready for issuing status...................73
New attributes for reinforcement....................................................................................74

1.19 New and deleted advanced options............................................................................74
New advanced options.....................................................................................................74
Deleted advanced options..............................................................................................77

2 Disclaimer....................................................................................................................79
Welcome to the Tekla Structures 2017 release notes!

This version comes with a bunch of new features and many bug fixes. The key features of this new version include:

- Object IDs changed to GUIDs (page 6)
- User interface improvements (page 7)
- Installation and multi-user server changes (page 12)
- Support for use in IPv4, IPv6 and dual mode networks (page 13)
- Modeling improvements (page 14)
- Model dump no longer available (page 28)
- Rebar sets - A flexible new way to create reinforcement (page 29)
- New tolerance settings in Rebar shape manager (page 37)
- Faster synchronization and other Organizer and Task manager improvements (page 38)
- Better performance and other drawing improvements (page 42)
- Drawing sketching and snapping improvements (page 56)
- Reference model and base point improvements (page 63)
- IFC export improvements (page 68)
- NC export improvements (page 69)
- EliPlan improvements (page 69)
- ToDo notes available in Trimble Connector (page 70)
- Applications & components catalog and component improvements (page 71)
- New template attributes (page 73)
• New and deleted advanced options (page 74)
• Tekla Structures 2017 fix list

Fixes by service pack
Follow the links below for information on fixes made in each currently available service pack:
• Tekla Structures 2017 cumulative fix list including all currently available maintenance releases
• There are currently no service packs or progress releases available for this version.

Compatibility
We suggest that you complete any unfinished models using your current version of Tekla Structures.

This version is not backwards compatible. When you create or save a model in Tekla Structures 2017, you cannot open it in older versions due to database differences.

Tekla Structures 2017 can only be installed on 64-bit Windows operating systems. Tekla Structures 21.1 was the last version that supports installation on 32-bit Windows.

See the hardware recommendations for more information.

To check which license server version to use with your current Tekla Structures version, see Which license server version to use.

Administrator's release notes
Advanced users should read the Tekla Structures administrator's release notes for information on how to apply the additional customizations available in this release.

Localization release notes
Environment-specific changes are explained in the Localization release notes.

Tekla Open API release notes
The Tekla Open API release notes are included in the Tekla Open API Startup Package, which you can download from Tekla Warehouse.
1.1 Object IDs changed to GUIDs
Object IDs have now been largely replaced by globally unique identifiers (GUID) in Tekla Structures. GUID is a permanent object property and can be used to identify objects reliably.

The numerical object IDs are now temporary information in all model types, including single-user and multi-user models. The ID number of the object may change when the model is reopened, or when the read in command is used in Tekla Model Sharing, and therefore the ID cannot be used as an object identifier in drawings, reports, and filters, for example.

1.2 User interface improvements
Tekla Structures 2017 comes with the following improvements in the user interface:

**Saving backup copies of models**
You have a new option to save and create a backup copy of your model. The backup copy will have the same GUIDs (globally unique identifiers) as the original.

![Image of backup copy option]

**Making company-level customizations**
You can now distribute customizations to a large group of users by using firm and/or environment folders.

- To distribute customized contextual toolbars, place the entire ContextualToolbar folder (located in ..\Users\<user>\AppData \Local\Trimble\TeklaStructures\<version>) in your company's firm folder or in the system folder, which is located under your environment folder: ..\ProgramData\Tekla Structures\<version> \Environments\<environment>\system.
• To distribute customized ribbons, place the entire Ribbon folder (located in ..\Users\<user>\AppData\Local\Trimble\TeklaStructures \<version>\UI) in your company’s firm folder or in the system folder, which is located under your environment folder: ..\ProgramData\Tekla Structures\<version>\Environments\<environment>\system.

• To distribute individual ribbon tabs, create a custom tab file and place it in your company’s firm folder, under Ribbons\CustomTabs\Modeling or Ribbons\CustomTabs\Drawing, depending on whether you want the tab to appear in the modeling or drawing ribbon (or both). Alternatively, you can create the same folder structure in your environment folder, under .. \ProgramData\Tekla Structures\<version>\Environments \<environment>\system."

For more information on custom tabs and company-level customizations, see Tekla Structures administrator’s release notes.

**More visual copying of object properties**

Now the mouse cursor changes into a paintbrush if the **Copy properties** command is active on the contextual toolbar.

For more information, see Copy properties from another object.

**Improvements in the contextual toolbar**

Tekla Structures 2017 contains many useful improvements for the contextual toolbar:
• You can change the visibility of object types directly on the contextual toolbar. Click the view to see the related contextual toolbar. Then click the eye button to display a list of object types:

![User interface improvements](image)

Click the small eye buttons to show or hide certain object types. In the left-hand column ( ), set the visibility of model objects. In the right-hand column ( ), set the visibility of component objects.
• You can now activate view filters, and color and transparency settings also from the contextual toolbar. Click the view to see the related contextual toolbar.

1. The left-hand list contains view filters.
2. The right-hand list contains color and transparency settings for model objects.

• You can customize the contextual toolbar even further by adding user-defined attributes and macros:

• You can move between the properties and command buttons on the contextual toolbar by using the Tab key.
• Surfaces, logical welds, and rebar sets now have their own contextual toolbars.

• New properties requested by our customers have been added to existing contextual toolbars:
  • **Position** for welds
  • **Numbering series** for assemblies
  • **Font** for dimensions, marks, and grids in drawings
  • **Fill background color** for circles, clouds, polygons, and rectangles in drawings
  • **Bulge** for lines, polygons, and polylines in drawings
  • **Explode** for polygons and polylines in drawings

• Direct modification settings are now located in an expandable section on the contextual toolbar. Click the small triangle symbol to show or hide the options:

Switching tooltips on or off
You can now choose whether tooltips should be visible or not.

To switch the tooltips on or off, go to **File menu --> Settings**. Under **Switches**, select or clear the **Tooltips** check box.
1.3 **Installation and multi-user server changes**

In Tekla Structures 2017, the installation of the Tekla Warehouse offline content has changed. A new version of the Tekla Structures multi-user server is now available. In addition to IPv4, this version of the multi-user server also supports connections over IPv6.

**Tekla Warehouse offline content available as .tsep packages**

Tekla Warehouse offline content is now available as `.tsep` packages (Tekla Structures Extension Package). Tekla Warehouse offline content is not any more installed at the same time as the Tekla Structures software. This makes installing the Tekla Structures software much faster than before.

When installing the Tekla Structures software, you can now select in the installation wizard whether Tekla Warehouse offline content `.tsep` packages are included in the Tekla Structures software installation. If you select to include the offline content, the `.tsep` packages are by default stored in the `C:\ProgramData\Tekla Structures\2017\Extensions\To be installed` folder, but they are not installed yet. You can remove the `.tsep` packages that you do not need by deleting them from the folder. The `.tsep` packages that are in the folder are installed when you start the new version of Tekla Structures for the first time.

Note that if you do not include the offline content when installing the Tekla Structures software, you can download the offline content later from Tekla Warehouse.

**New version of Tekla Structures multi-user server**

Tekla Structures multi-user server 2.5.0 is now available in Tekla Downloads. We recommend the new server version for all users of the Tekla Structures multi-user system.

With the new server version in use, Tekla Structures 2017 can be used in:

- IPv4 networks
- IPv6 networks
- networks that use both IPv4 and IPv6

**Editing drawings**

Editing drawings is improved with the new server version. Previously, when you edited a drawing in a multi-user model, the drawing lock was sometimes not cleared and the drawing appeared to be locked after saving the drawing.
and the model. In addition, a warning message was shown to other users of the model even though they saved the model. This does not happen anymore.

1.4 Support for use in IPv4, IPv6 and dual mode networks

Tekla Structures 2017 can be used in networks that use IPv4, IPv6, or both the IPv4 and IPv6 protocols. This enables companies that have only IPv6 Internet Service Provider (ISP) addresses to use Tekla Structures.

IPv6 (Internet Protocol version 6) is an evolution of IPv4. IPv6 is usually supported in up-to-date hardware and operating systems, and often already activated and configured as well. IPv6 is installed as a software upgrade in most devices and operating systems. With the current transition methods, it is possible to gradually start using IPv6 in parallel with the IPv4.

See the image below for an example of a network using the IPv6 protocol.

In the image, the numbers indicate the following:

1. Internet
2. Internet connection
3. ISP router
4. Firewall
5. Router
6. Workstation switch
7. Server switch
8. IPv6 connection

1.5 Modeling improvements
This version makes modeling easier in several ways. The highlights include improvements in selecting and snapping, several improvements in direct modification, and further development that helps you modify the bent plates created using the new bent plate feature introduced in Tekla Structures 2016i. We have also revised the help materials on filtering, so if filtering has seemed confusing so far, it may pay off to read through some of the new instructions and examples.

Selecting objects hidden behind other objects
• You can more easily select objects that are hidden behind other objects. For example, you can select reinforcing bars even if they are hidden behind the surface handle (the yellow area in the image) of a nearby object:

Direct modification improvements
• In previous versions, you needed to press the Shift key when dragging a direct modification handle to an existing snap point or line. This has been changed so that snapping to points and lines is enabled by default. If you temporarily want to disable snapping to points and lines, press the Shift key.
• You can move point and line handles to any location in the 3D space by using the new **Move in 3D** command. The command becomes available on the contextual toolbar when you select a point or line handle.

![Contextual toolbar screenshot](image)

You can still restrict handle movement if needed. With point handles, you can use the **Move in XY plane** and **Move in Z direction** options. With line handles, you can use the **Move in parallel direction** and **Move in**
**perpendicular direction** options. In plane views, the handles always stay in the view plane even if the **Move in 3D** command is switched on.

- You can also restrict handle movement to a selected part plane. This can be useful when working with a sloped roof, for example. Click the **Move in selected plane** button on the contextual toolbar, select a part plane, and then drag the handle to a new location. The handle can be moved in the selected plane only.

For example:
• Tekla Structures remembers the snap mode setting (Move in 3D / XY plane / Z direction / parallel direction / perpendicular direction) until you close the model.

• You can now control the visibility of all direct modification dimensions. Click the button to show the options, and then click the eye button to show or hide dimensions:
• **X, Y, Z dimensions**: All orthogonal dimensions in the work plane directions X, Y, and Z are displayed.

• **Total dimensions**: Only the total length is displayed.

These visibility options are available for parts, cuts, construction objects, and rebar sets. Tekla Structures remembers the visibility setting when you create or open a new model, or restart Tekla Structures.

• You can now enter an exact distance when moving a direct modification handle. Drag the handle and type the distance. When you start typing,
Tekla Structures displays the **Enter a Numeric Location** dialog box automatically:

- Polygon cuts now have a plane handle which can be used for modifying the thickness of the cut:
• Direct modification is now also available for line cuts:
• Tekla Structures now tries to keep dimension lines and values in the view even when you zoom in or move the view. Dimensions may be moved to another side of the part, for example:

• Dimension arrowheads and custom part placing handles now keep the same size, regardless of the zoom level:
• Tekla Structures now only shows the dimensions that are relevant in each view. In the following example, the perpendicular (red) dimensions are visible in the previous version of Tekla Structures but hidden in Tekla Structures 2017:

<table>
<thead>
<tr>
<th>Part perspective view</th>
<th>Part end view, Tekla Structures 2016i</th>
<th>Part end view, Tekla Structures 2017</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Part perspective view" /></td>
<td><img src="image2.png" alt="Part end view, Tekla Structures 2016i" /></td>
<td><img src="image3.png" alt="Part end view, Tekla Structures 2017" /></td>
</tr>
</tbody>
</table>

• You can now create temporary reference points when creating new objects using direct modification.

**New snap settings**

General snap settings are now available in **File menu --> Settings --> Snap settings**. Previously, these settings were located in the **Options** dialog box, under **Mouse settings**.

Also new snap options for the **Ortho** tool have been added:
Bent plate improvements

Tekla Structures 2017 contains many useful improvements that help you modify the shape of existing bent plates.

• You can edit the bend radius directly on the contextual toolbar:
You can change the shape of the curved section by choosing one of the predefined options:

<table>
<thead>
<tr>
<th>Tapered bend</th>
<th><img src="image1" alt="Tapered bend" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>A gradual decrease in the width between the parts. This is the default option.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Narrow bend</th>
<th><img src="image2" alt="Narrow bend" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant width between the parts. The width is determined by the narrowest part.</td>
<td></td>
</tr>
</tbody>
</table>
Wide bend

Constant width between the parts. The width is determined by the **widest** part.

- Additionally, you can modify and fine-tune the curved section manually by dragging the blue boundary handles:

  For example:
• You can also change the shape of the flat sections. When you click the green selection handle of the section you want to modify, the direct modification handles of the selected section become visible:

• You can remove individual curved sections by clicking the **Remove bend** button on the contextual toolbar. For example:

![Diagram showing the process of removing curved sections](image)

**Custom Inquiry available in side pane**

**Custom Inquiry** is now available in the side pane. Click the **Custom Inquiry** button in the side pane to view model object properties using **Custom Inquiry**.
Alternatively, you can still click the down arrow next to on the ribbon, and then select Custom inquiry.

Custom Inquiry works in the same way as before, only the user interface has been slightly improved.

For more information, see Custom inquiry and How to use the side pane.

**Improvements in clash checking**

A new clash check setting is now available in File menu --> Settings --> Options --> Clash check.

Use **Allowed penetration volume** to define an allowed clash check tolerance if small collisions are acceptable and can be ignored. Enter the tolerance in the current volume units.

If the clashing volume in the model is smaller than the given value, for example 1 mm³, then the clash is not reported.
New command for showing all detailing of a part

A new command **Display detailing** is now available for showing all objects and detailing related to a part. For example, you can use this command to examine whether parts are cut or welded correctly.

1. Select a part.
2. Click **Display detailing** on the contextual toolbar.
   Alternatively, you can press **Alt+D**, or use **Quick Launch**.

For steel parts, Tekla Structures displays all parts, bolts, welds, cuts, fittings, and other details belonging to the assembly, even if you had defined them as hidden in the display settings. For concrete parts, Tekla Structures displays also reinforcement, surface treatment, and surfaces.

Documentation updates for filtering

The instructions for the filtering functionality have now been revised, as requested by many of our readers. Please note that the functionality itself has not been changed. The instructions now contain detailed information about the various object properties that you can use in filter rules. Also more information on how to use conditions and brackets have been included. All example filters have been checked and improved to contain more complex filter rules, brackets, and so on.

1.6 Model dump no longer available

The model dump functionality is no longer available in Tekla Structures.

If you have problems with the model, use the commands available in **File menu --> Diagnose & repair**. We recommend you to diagnose and repair your
model regularly to maintain the consistency and integrity of your model databases.
1.7 Rebar sets - A flexible new way to create reinforcement

Tekla Structures 2017 introduces rebar sets that are a very flexible and versatile method to create reinforcement. Using rebar sets you can reinforce various areas in concrete parts, as well as in pour objects, or outside concrete objects. Rebar sets are adaptive to the changes in concrete parts, and updated automatically if the dimensions or concrete cover thickness of the parts change.
It is most beneficial to use rebar sets when you reinforce large slabs with openings, irregular profiles, such as retaining walls and box girders, or pour objects, or create crossing bars in polybeams and strip footings.

The new Rebar set commands are available on the Concrete tab:
When you create multiple rebar sets in a concrete part, Tekla Structures automatically arranges overlapping bars at each part face to layers. If needed, you can easily fine-tune the order of the bar layers.

**Rebar sets are easy to modify**

Rebar sets are reinforcing bars that you can easily modify as a group, or only at certain locations. You can use direct modification, and the new methods specific to rebar sets: guidelines, leg faces, and local modifiers.

For more information about the new objects related to rebar sets, see Basic concepts related to rebar sets.

The example below shows the planes (the gray leg faces) that define where the reinforcing bar legs are created, and how the rebar set guideline (highlighted in yellow) defines the distribution direction and spacing of the reinforcing bars.
In the following examples, rebar set modifiers have been used to modify the rebar sets locally. A magenta end detail modifier adds hooks to the bar ends it affects, and a green property modifier changes the properties of certain bars only.

You can cut rebar sets using the cutting commands on the Edit tab, and modify the cuts using direct modification. You can also split and splice bars with splitters, which are one type of modifiers.
Rebar set properties available in the property pane

You can view, define, and modify the rebar set properties on the contextual toolbar and in the property pane, which is a new window available through the side pane.

- To open the property pane, double-click a rebar set in the model, or click \[ \text{gear} \] in the side pane.
• To apply the modified properties (highlighted in yellow) to the model, click in the bottom left corner of the property pane.
• To save the properties for later use, enter a name for the properties file in the topmost box in the property pane, and then click .
• If you want to use previously saved properties from a file, select the properties file from the topmost list in the property pane:

The property pane is also available for the following rebar set specific objects:
• Leg faces
• Secondary guidelines
• Property modifiers
• End detail modifiers
• Splitters
New settings related to rebar sets

In Tekla Structures 2017, there are new **Reinforcement** settings related to rebar sets in the **Options** dialog box:

You can define the default concrete cover thickness of the rebar sets in a model, and the minimum lengths for the bars and end legs that will be created.

To define the cover thickness of the rebar sets in an individual concrete part, you can use the **Concrete Cover** tab in the user-defined attributes of the part.

Tekla Structures 2017 also introduces a new advanced option `XS_REBARSET_COLOR_BARGROUPS` that you can use to set the coloring of rebar set bars in model views.

Rebar sets in drawings

The reinforcing bars that are created by using the **Rebar set** commands are automatically grouped for drawing marking and dimensioning purposes. For more information about rebar sets in drawings, and how to dimension and mark the rebar sets, see Automatic grouping of rebars sets for drawings.
Rebar sets in numbering, reports, and Organizer

All reinforcing bars that are created by using the Rebar set commands are individual bars, which means that:

- In numbering, each bar in a rebar set receives its own position number.
- In reports, the bars in rebar sets are listed individually. To combine identical rows in Template Editor, set Sort type to Combine in row properties. To sum the values of identical bars, you can use the Sum values across all rows option under When rows are combined for value fields in Template Editor.
- In Object Browser, the bars in rebar sets are listed individually on separate rows, and the Quantity column shows 1 on each row. If you combine identical rows, the Count column shows the number of identical bars.

Limitations

- Roundings in bent bar corners are not taken into account in automatic clash avoidance when Tekla Structures creates rebar sets and arranges them to layers.
- You cannot create rebar sets in deformed parts.
- You cannot create crossing bars in polybeams or variable cross sections if the angle between neighboring segment faces is larger than 45 degrees.
- Tapered bar groups within rebar sets do not have position numbers, so position information is not included in reinforcement marks in drawings.

1.8 New tolerance settings in Rebar shape manager

Tekla Structures 2017 introduces new settings in Rebar shape manager. On the new Tolerances tab in the Rebar shape manager dialog box, you can define the tolerances that are used when the bending shape rules are compared. You can define tolerance values for the following measurements:

- **Dimension** (leg lengths and other distances)
- **Angle** (bending and twist angles)
- **Radius** (bending radiuses)
- **Extra point shortening**
- **Extra point max angle**
Note that the tolerance values are stored along with the rule file RebarShapeRules.xml, and thus the tolerances are specific to each rule file.
For more information, see Define reinforcing bar bending shapes in Rebar shape manager.

1.9 Faster synchronization and other Organizer and Task manager improvements
Tekla Structures 2017 introduces improvements in Organizer synchronization and reporting. With Task manager, you can now show a sequence in the model.

Faster synchronization in Organizer
Organizer is synchronized significantly faster than before. Synchronizing Organizer now updates all properties of only the changed objects in the Organizer database. This is useful especially if you have changed only a few objects in the model. Previously, the properties viewed in Organizer were updated for all objects at synchronization.

When you have viewed a property of any object in Object Browser, the property will be updated in the Organizer database at synchronization.

Note that in some cases the whole Organizer database is still synchronized. This happens when synchronizing a model for the first time, or when you have enabled the pour functionality, for example.

Reloading Object Browser
When you reload Object Browser, the viewed properties are refreshed to display the current situation in the model. The refreshed properties are also updated in the Organizer database.

When you have viewed a property of any object in Object Browser, the property will be updated in the Organizer database at synchronization.

More fluent and faster reporting in Organizer

View a limited number of objects in Object Browser
Object Browser now has a predefined limit for listing objects. As loading object properties takes time, the limit is useful if you have selected a large number of objects in the model or in the categories. When you select more than the predefined number of objects, Object Browser does not at first show
the objects. Instead, **Object Browser** shows how many objects you have selected and what the predefined limit is.

You can change the predefined limit by entering a number in the box. The number you enter in the box becomes the default value. You can also set the limit in **Organizer Settings**, on the **Synchronization** tab.

![Object Browser interface](image)

- Click ![Show objects](image) to show the objects and the object properties stored in the **Organizer** database.

- Click ![Reload properties and show objects](image) to reload the object properties and then show the objects.

**Show objects from the model or the categories**

**Object Browser** automatically shows objects either from the model or from the categories based on what you have last selected. On the **Object Browser** toolbar, the automatic selection ![A](image) button is selected by default. If you have a category selected, **Object Browser** only shows the objects that are in the category. If you have selected objects in the model, **Object Browser** only shows these objects.

![Automatic selection button](image)

You can switch off the automatic selection to control the selection. Click the ![A](image) button to select the other selection buttons:

- Click ![show model objects](image) to show objects from the model.

- Click ![show category objects](image) to show objects from the categories.
Set Object Browser summary row details

The options for defining how property values are shown in the Object Browser sum row and combined rows have been renamed in Organizer Settings. The sum row option also has a new value available.

• Use **In sum row show** to define how the property values are shown in the sum row. Previously, this option was called **Show result in sum row**. You could either select the option to show the result or leave the check box unselected to not show the result. The corresponding values are now **Result** and **-**.

The new sum row value **Single value** allows you to select whether you want the row to show a property value only when all the objects in Object Browser have the same value in the property column.

• Use **In combined row show** to define how the property values are shown in combined rows. Previously, this option was called **Show result in combined rows**.

Report object properties to Excel

The latest object properties are now by default updated to Object Browser for the Excel export. The **Update object properties from model** option in the Export data to Excel dialog box is by default selected.

Pours in Organizer

When you have the pour functionality enabled, Organizer shows the pour object hierarchy instead of the cast-in-place object hierarchy.

Select categories

When you have selected a category in Organizer, the objects in the category now stay selected when you right-click another category. Right-clicking a category does not select the category anymore. When you right-click a category, you can only add objects to the category. To use all the category commands, you need to select the category first.

View objects in a pie chart

When you have grouped objects in Object Browser, you can now create a pie chart to view the ratio of the number of objects included in the groups. Press
Alt+F12 to create the pie chart. You can copy the pie chart to any document by using the Ctrl+C and Ctrl+V commands.

Use Task manager to show a sequence in the model

You can now show a sequence in the model by using **Task manager**.

In the **Task information** dialog box, first set the sequencing order for the objects on the **Objects** tab. Then select the relevant objects in the table and click the **Play** button. The objects are selected in the model in the same order as they are listed on the **Objects** tab.

You can change the speed of the object selection by typing a different number in the box next to the **Play** button. The default is 1 second.
1.10 Better performance and other drawing improvements

Tekla Structures 2017 has several improvements and new features in drawings including improved drawing opening, better drawing performance, new option for marking drawings ready for issuing, new command for deleting marks for selected parts at one go, new gray line colors, fills for neighbor parts, more consistent logic in openings and recesses, colors in snapshot overlays, improvements in reinforcement dimensions, automatic hatches that can be defined separately for precast and cast in place, improvements in custom grid labels, and many more.

More informative opening of drawings

Now you get more information on what is going on while you open drawings:
• You can now see a snapshot of a drawing, while that drawing is opening, if a snapshot has been created for the drawing.
• A message box is displayed showing the progress and what is happening.
• The Cancel button in the message box now works and you can cancel the opening of the drawing.

Improved drawing performance

Drawing performance has been improved in several operations:
• Updating of part, reinforcement, and annotation marks
• Reference model rendering. Now drawings open faster also when reference models use hidden lines.
• Object level settings
• Filtering
• Rebar rendering
• Hatching of parts faces and sections
• Cloning
Mark drawings ready for issuing

When a drawing is ready to be released for fabrication, you can now mark it ready for issuing by using the new option Ready for issuing On/Off in the Drawing list. You can also find this command in the pop-up menu.

- When there are changes in the model, the geometry of the issued drawings is updated. The drawing can still be edited and updated, and works just like any other drawing.
- When a drawing is marked ready for issuing, it is flagged with a green check mark in the new Ready for issuing column in the Drawing list. You can check who marked the drawing from the Ready for issuing by column.
- The Mark drawing ready for issuing option has replaced the Disable automatic updating (Freeze) option in the save confirmation message box, which appears when you close an unsaved drawing.

![Tekla Structures drawing](image)

- The Freeze option is still available in the Drawing list for those who need it.
- Template Editor contains new attributes IS_READY_FOR_ISSUE and READY_FOR_ISSUE_BY for this new functionality. You can include the attributes in reports, for example.

Both letters and numbers allowed in section view labels

There is a new option available in the Section view properties in all drawing types for adjusting the section view and section symbol labels: Start number or letter of section view and symbol label.

- You can enter any number starting from 1, or any letter A - Z or a - z (also shown in uppercase in the label).
- If you use a letter, and the entered string is longer than one letter, only the first letter is shown. If you use numbers, all entered numbers are shown.
- The start number in the label changes only when you change it in the drawing properties before creating a drawing, and when you change it in an existing drawing and recreate the drawing. When you change it in an
existing drawing and recreate the drawing, the labels for all automatically included section views and all new section views will change.

Delete marks of selected parts at one go

With the new command **Delete part mark** you can easily delete the part marks of parts that you have selected. This command comes in very handy when you do not want to show marks for neighbor parts or neighbor reinforcement, for example.

- To delete marks, activate the **Select parts** selection switch, select the parts using a proper selection filter, right-click and select **Delete part mark**.

In the following example, you want to delete all marks except marks for cast units with a position number B/1. When you apply this filter, activate the **Select parts** selection switch, and use area select to select the parts, all other parts get selected.
The image below shows the parts that have been selected and the marks that you want to delete.

To delete the marks, right-click and select **Delete part mark**.

- You can delete all other mark types, except weld marks.

**New gray drawing line colors**
- Now lines in all drawing types, in all building objects, annotations, dimensions, and drawing sketch objects have four new gray colors available. The different gray shades are true colors in the way that they will
keep their color regardless of the drawing color mode, all the way to printing.

Below is an example of architectural linework drawn directly from an architectural IFC model. Light gray is used here.
Fill available for neighbor parts

- The Fill tab has been added to the Neighbor part properties. For example, if your drawing shows a pour, you may want to show other parts with a different color than pours, and add a different fill.

Improved custom grid labels

- The Advanced grid label properties dialog box now has a new user interface. Earlier there were problems with the dialog box size and buttons that were not working properly.

- In custom grid labels, you can now select which symbol file to use, and select the symbol by double-clicking it in a separate window, which opens when you click the ... button.

- The symbol height has three new options. If you select Enter height, you can enter the height in the Height box. If you select Autosize, the symbol height is adjusted automatically. Use the option Enter Autosize minimum height to set the minimum height for the symbol.

- Now you can also enter the grid axis text and prefixes in the Advanced grid label properties dialog box. Earlier, these values could only be entered in the user-defined grid properties in the model.

- The minimum allowed size in the Grid number and Grid text boxes in the Advanced grid label properties dialog box is 1.0.
• Grid labels created in Tekla Structures version 2016i are not compatible with version 2017. You need to recreate the labels.

Add images from 2D Library
You can now insert images to drawings from the 2D Library.
• Open the 2D Library and browse for the folder containing the desired image files. Alternatively, you can move your image files to the Drawing Details folder under the current model folder. To place the image, select the file and click the drawing view or drawing.
• If the file is inserted from outside the model folder, Tekla Structures will copy the file to the model folder first, and the insertion path will be relative to that.
• You cannot include images in new details.

Filtering improvements
• Now the Selecting toolbar also contains a Selection filter button in the drawing mode. When you click this button, the Selection filter dialog box is displayed allowing you to create and modify drawing selection filters.
• You can also open the Selection filter dialog box by pressing Ctrl+G or entering Selection filter in the Quick Launch box.
• You can now select Reference object as the Object type.
• The option Id number has now been removed from drawing filtering properties. Use the filtering property GUID instead in assembly, reference assembly and reference object filtering.

Openings and recesses drawn correctly
• The openings and recesses logic is now more consistent. If you use a polygon or a part cut for cutting, the resulting opening or recess is visible in drawings. If the cut is created by modifying part points, the opening/recess
is not shown. Hollow profiles are now drawn correctly using the correct symbols. Complex cuts, like L, U or O shapes, are not supported.

• Note that if you open a drawing from an older Tekla Structures version, the opening and recess symbols may change.

• The following advanced options define how the openings and recesses are shown:
  XS_USE_CROSS_FOR_OPENING_SYMBOL
  XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES
  XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES

Inch marks now shown after fractions of an inch
  • Now inch marks are also shown after fractions of an inch in dimension texts.

$\frac{13}{16}''$

Rich text file improvements
  • Now you can also use underscore, hieroglyphs, superscript and subscript in the .rtf files added in drawings with the command \texttt{Rich text}.
  Nested lists are also supported.
Select all (Ctrl+A) in drawing texts

- You can now select all text in the Text box in the Text properties dialog box by pressing Ctrl+A.

Improved snapshot overlay with color support

- In model snapshot overlays, the plan views are now located on the correct plane.
- The text "Snapshot" and the layout of the drawing are no longer displayed in the snapshot overlays in the model.
- You can now change the snapshot overlay color.

- You can now snap to drawing snapshot overlays with the Snap to geometry lines/points snap switch.

AutoDrawings available in Quick Launch

The AutoDrawings command is again available as a separate command. An AutoDrawings wizard is a file-based wizard consisting of several sets of drawing requests containing drawing, attribute and part settings to apply to selected objects, as well as a selection filter.

- You can open the AutoDrawings dialog box by entering AutoDrawings in Quick Launch.
• You can also create a keyboard shortcut for starting AutoDrawings through **File --> Settings --> Keyboard shortcuts**.

**New option to define automatic hatches separately for Precast and CIP**

You can now specify automatic hatches separately for cast-in-place and precast parts using the new option **Cast unit type** in the drawing hatch schema file (.htc). This can be useful in GA drawings for presenting different types of concrete structures, or in cast unit drawings for identifying different concrete layers in composite elements, such as double walls or half-slabs.

• The allowed values are **Precast** and **CIP**.
• There are separate .htc files for each drawing type.
• To be able to specify hatches separately, you need to select the appropriate cast unit type in the concrete part properties.

• Automatic hatching also supports the new gray scale colors. New color numbers are 130 - 133 from darker to lighter.

**Improvements in reinforcement dimensions**

Tekla Structures 2017 contains plenty of improvements and fixes in rebar dimensioning:

• You can add tapered skewed and tapered curved dimensions to both ends of the part, and the dimension line follows the shape of the edge that is closest to the location that you pick. The representation of the tapered skewed and tapered curved dimensions is set in **Drawing dimensions settings** in the **Options** dialog box.
Now you can also add middle tags in curved rebar dimensions on the Tags tab in the Dimension Properties dialog box. In the example below, dual dimensions are applied so that you can see metric above and imperial below in the middle tag:
• There is one new option in the *Curved dimension tag type* list on the *Tags* tab in the *Dimension Properties* dialog box. When you select this option, the dimension tag follows the dimension curve:

• When you select option , vertical rebar dimension tags are now placed correctly:
Rebars visible in reference models in drawings

- Rebars are now shown in reference models in drawings.

New content type option in Rebar mesh view creator

- RebarMeshViewCreator is a macro that you can use for creating a separate drawing view for a reinforcement mesh. A new option **Unit of length in text** has been added in the **Rebar mesh view creator** dialog box to control the unit of the wire length (L=...) text in the annotation text. When
you select Auto, with imperial units the text will be using the current units, and otherwise the text will use m.

New location for loading drawing presentation and dimensioning plug-ins

Drawing presentation and dimensioning plug-ins are now loaded from the following pre-defined folders:

..\common\extensions\custom\dimensioning
..\common\extensions\custom\presentation

Earlier, custom properties were loaded from all folders and subfolders in ..\common\extensions. This caused performance issues and loading failures when custom properties were used. Now the custom properties are loaded only from the extension folder ..\common\extensions\custom\properties\. This speeds up the loading process and solves loading problems caused by other software components in other extension folders. New functionality for loading custom properties can be switched off in startup .ini files by defining the following advanced option:

set XS_ENABLE_FAST_CUSTOM_PROPERTY_LOADING=FALSE

When you do this, the loading of custom properties works as in previous versions.

1.11 Drawing sketching and snapping improvements

Sketching graphical objects and snapping in drawings both contain a lot of improvements that help you to sketch in drawings in a more organized manner. These include more visual sketching tools, more flexible cover-up tools, new option for re-ordering graphical objects, and snapping to custom angles.
Increased visualization in sketching tools

• Now when you draw graphical objects like polylines and polygons, you can see the resulting shape right away. The line lengths are also shown.

• Radius is now shown when you draw arcs and circles.

• The target view scale is now applied when you copy graphical objects from one view to another, which means that the scale of the object and the related numerical information adjust to the scale of the target view.

• The temporary sketch object dimension line and dimension text properties, and other dimensions properties are taken from the current settings in the regular dimension properties dialog box. This means, for example, that units can be controlled in the same way as for the other dimensions.

• Now numeric input works when you move polyline and polygon handles.
More flexibility to cover-up tools

- Tekla Structures 2017 introduces two new cover-up tools:
  - Draw cover-up polyline
  - Draw cover-up polygon

- The name of the **Cover-up area** command is now **Cover-up rectangle**.

- You can explode a cover-up polyline into separate straight cover-up lines, and combine cover-up lines and polylines into closed cover-up polygons.

- The cover-up object dimensions are shown while you draw the object, and also when the object is selected. You can resize and reshape the cover-up objects by dragging the handles.

- Note that the **Re-order** command in the pop-up menu has no effect on the cover-up objects. To have a cover-up area hiding sketch objects, such as polygons and polylines, use **Re-order** for the sketch object and send it behind the model object.
Possibility to re-order objects

In drawings, you may want to indicate positions of openings, windows, doors and such by sketching graphical objects. You can change the mutual order of the sketch objects (graphical objects), and the mutual order of the sketch objects and model objects. You can bring sketch objects forward or in front of other sketch objects, or send them backward or behind other sketch objects, and also send sketch objects behind model objects or bring them in front of model objects. You can also re-order DWGs and images in the same way.

If you have several objects (objects on several layers), the drawing order affects the layer on which the forward and backward commands place the objects. Newly created sketch objects are placed on their own layer in the drawing order: the newest one on top of the older one.

To re-order, right-click a sketch object, DWG or an image and click Re-order. Then select one of the following commands:

- **Send backward**: Moves the selected object one step closer to the back of all other sketch objects.
- **Send to back**: Places the selected object behind all other sketch objects.
- **Bring forward**: Moves the selected object one step closer to the front of all other sketch objects.
- **Bring to front**: Places the selected object in front of all other sketch objects.
- **Send behind model objects**: Places the object behind all model objects. You can also set this option in the sketch object properties dialog box (Behind model objects --> Yes).
- **Bring in front of model objects**: Places the object in front of all model objects. You can also set this option in the sketch object properties dialog box (Behind model objects --> No).

Showing an opening:
Highlighting the footing area in a drawing by placing a gray polygon behind footings:

- Note that sketch objects that are placed behind model objects cannot be re-ordered together with sketch objects that are placed in front of model objects.

**Improved Copy with offset**

- When you create a line with a bulge and copy the line using Copy with offset, the created line now has the same bulge as the original one.
- If the rectangle has no bulges, the copied object will still be a rectangle after you use Copy with offset, just like before. But if the original rectangle has a bulge, it is not possible to copy it to a new rectangle using Copy with offset. When you use Copy with offset, the new copied object will become a polygon.

**Improved snapping in drawings**

- You can now snap to custom angles in drawings. This is useful when you are sketching polylines and polygons, for example.
  - Angles become visible when you activate orthogonal snapping by pressing O (or selecting File -> Settings -> Ortho) and specify custom
angles and/or snapping steps in the renewed **Drawing snap settings**
dialog box. To open this dialog box in the drawing mode, click **File -->
Settings --> Snap settings**.

- Using ortho snapping to custom angles is also useful if you need to
place annotation objects in a consistent manner, for example. In the
example below, you first add a text with a leader line using a 60 degree
angle to the part:

![Drawing example](image)

Then you will add a new text using the same angle:
• Note that setting the snap settings in the model has no effect on a drawing, and vice versa.

• Free snapping in drawings is now based on the zooming level: The closer you zoom, the more exact you can sketch. For example, you can now more easily create rectangles that are of exact length when you zoom closer. The snapping step changes from 1 to 1000 (1/16" - 5') depending on the zoom level.

• You can now snap to drawing snapshot overlays with the Snap to geometry lines/points snap switch.

• Now you can snap to drawing layout items as well as to the drawing frame using the Snap to dimensions and mark lines snap switch.

Improved pattern lines

• It is now easier to add symbols in pattern lines. You can now select the symbol by double-clicking it in a separate window, which opens when you click Select.
• If you use dashed lines in a line pattern, the dashes are justified to the corners of a line segment, so lines do not start with spaces. The dashes are justified if the pattern is longer than the line itself. Printing and DWG/DXF export do not support this change yet.

1.12 Reference model and base point improvements

Reference models now use customizable comparison sets in change detection. There are some new controls making the comparison, change detection, and conversion management more fluent and extensive. In conversions management, the object type is now visible in the changes list. There are also some improvements in general reference model handling and base point functionality.

Improvements in reference model change detection

Comparison sets
• Change detection in Tekla Structures now compares different versions of the reference model based on a comparison set, which tells you whether Tekla Structures considers a change in a property a change or not. You can use the standard property comparison set, or define comparison sets of your own.
• In the reference model, when the change detection is active, the changes list shows all deleted, changed, new and not changed objects. The property
details list only contains those properties that are defined to be compared by the current comparison set rules.

• To create a new comparison set, in the Change detection section, click Comparison sets to open the Comparison sets dialog box. Add new rules by clicking Add row, activate/deactivate fixed rules, enter a name for the set, and click Save.

• You can also copy and paste properties from the property details list.

• If you decide that you do not need a comparison set, select it from the list and click Delete. You can also delete individual rules that you have created by clicking Delete row.

Other improvements in reference model change detection

• There is now a new This model is newer check box in front of the file path in change detection. Select this check box to define that the file shown in the file path box is newer than the other compared file. If the file has been updated, it appears in the box automatically and the check box is selected.
• It is now possible to compare as newer (default) or older.

• New columns **Material**, **GUID** and **Profile** were added in the changes list, and the **ID** column was removed.

• You now have a new check box **Get selected from the model**. When you select it, and click an object in the model, Tekla Structures finds the object row in the changes list, sets the focus on that row, and shows the details list for the selected object.

• You can zoom to deleted objects in change detection using the **Zoom to selected** check box. The **Zoom to selected** check box is disabled if the **Select objects in the model** is not selected.
• The older state of a reference model object is now drawn to the 3D view in orange color when you select the corresponding object.

Improvements in reference model conversion management

• Selecting a reference model object in conversion management changes list also selects the related native object in the model. Now you can more easily modify model object properties, and use Get to get part properties, or Inquire parts, for example.

• You now have a new check box Get selected from the model. When you select the Get selected from the model check box, and click an object in the model, Tekla Structures finds the object row in the changes list, sets the focus on that row, and shows the details list for the selected object.

• The IFC conversion management changes list now shows the IFC object type:

- B-reps are shown as Surface geometry.
- Arbitrary shapes are shown as Arbitrary. Assembly is also Arbitrary, as well as reference objects that you select using the Select objects in assemblies or Select objects in components selection switches.
• Parametric profiles are shown as **Parametric**.

• The object type is also included in **Inquire** reports:

| IFC object type | : Parametric |

### New macros for selecting converted or corresponding objects

There are two new macros available for selecting objects:

- **SelectConvertedObjectsBasedOnIfcObjectsSelection** for selecting the converted objects, and
- **SelectCorrespondingObjectsBasedOnIfcObjectsSelection** for selecting the corresponding objects.

The new macros are located in the **Applications** group of the **Applications & components** catalog.

- **SelectConvertedObjectsBasedOnIfcObjectsSelection**
  
  In conversion management, this macro selects the objects that have been converted to native Tekla Structures objects. You may need to select the converted objects to check the properties of the native Tekla Structures objects, for example.

- **SelectCorrespondingObjectsBasedOnIfcObjectsSelection**
  
  This macro is useful in change detection for cases where you exported native objects to IFC, inserted the IFC model back to the same native model, and then you want to select the corresponding Tekla Structures objects. You may need to select the corresponding Tekla Structures objects when you want to add your own UDAs to all updated and selected native objects, for example.

### Other improvements in reference model handling

- In the **Add model** dialog box and reference model details, you can now pick the **Rotation**. Previously you had to type the value in the box.

- Dragging and dropping reference models between groups has been improved.

- The eye button in **Reference models** list is now disabled if there are no models in the reference model group.
• Now you can also refresh locked reference models with the **Refresh** button.

To do this, set the new advanced option

```plaintext
XS_REFRESH ALSO LOCKED REFERENCE MODELS to TRUE in File --> Settings --> Advanced options --> Import.
```

This system-specific option is by default set to **FALSE**.

• Performance is improved for those IFC reference models that use instancing, and inserting components with shared definitions, such as windows, furniture, and flow segment terminals is now faster.

**Improvements in project base point functionality**

• In the **Base point** dialog box, you can now pick **Angle to North**. Previously you had to type a value in the box.

• The base point location in the model changes according to the location or rotation changes you make in the **Base point** dialog box when you press **Enter** or click another input field. Earlier you needed to click **Modify**.

1.13 **IFC export improvements**

IFC export introduces a new IFC export type option.
**New IFC export type Coordination view 1.0**

The new IFC export type option Coordination view 1.0 is recommended to be used instead of Coordination view 2.0 when you need to have voids and openings presented by using opening elements.

In this export type:

- Reinforcing bars are exported as extrusions.
- Voids and openings are exported as opening elements (ifcOpeningElements).
- Curved elements are exported as extrusions.
- Bolts are exported as B-rep.

**1.14 NC export improvements**

Tekla Structures 2017 introduces a couple of improvements in pop-marks and NC file settings.

**New option allowing pop-marks for parts welded on site**

The Pop-mark Settings dialog box now has a new option Add pop marks to parts welded on site that allows you to create pop-marks for parts that are welded on site.

**Pop-marks created based on the weld primary and secondary part**

Previously, pop-marks were created based on the assembly main and secondary parts. Now the pop-marks are created based on the weld primary and secondary part.

**Maximum diameter for circular cuts to be drilled**

In NC file export, circular part cuts are now written as holes if the diameter of the cut is less than the value defined for the new setting Maximum diameter for circular cuts to be drilled in the NC file settings dialog box. Smaller internal circular cuts are converted to holes.
1.15 EliPlan improvements

There are some new features both in EliPlan export and in EliPlan import.

Export EliPlan (68)

- You can now set a special tag for elements that have notch cuts using the new option Tag special elements.
- A new option Numbering must be up to date to export was added to enable or prevent the export when the numbering is not up to date.

Import EliPlan (69)

- Import EliPlan status data (69) now supports the import of info texts.

1.16 ToDo notes available in Trimble Connector

Tekla Structures is able to connect Trimble Connect for sharing reference models using Trimble Connector. The new ToDo functionality in Trimble Connector displays the ToDo notes added to the project. You can add ToDo notes and reply to notes of other project members. The ToDo notes are shared to all project members by default, but you can select a user or a user group who to assign the ToDo with a due date when it needs to be resolved.

- To display a list of ToDo notes, click the ToDo button in Trimble Connector. You need to open a project to show the ToDos for the project.

- You can:
• Sort the ToDo list: Select to sort by Author, Assignee, Due date, Status, or Priority.
• Search for ToDo notes: Use Search to search for specific ToDos.
• Group ToDo notes: Select to group by Author, Status, Priority, Creation date, or Last modified date.
• View a ToDo: Double-click the ToDo in the ToDo list.

• Create a ToDo: Click the Create ToDo button. To create a ToDo with a view and a snapshot, select the native Tekla Structures objects before clicking the command.
• Comment a ToDo: Double-click a ToDo note and add your comments in the opened property pane.
• Assign a ToDo: Double-click the ToDo note you want to assign, and click the Edit button. In the Assignee box, click Select and select a project member or user group from the list, or start typing the name of the user or user group to filter the user list. Select the due date from the calendar, and add priority and status if applicable.
• Synchronize ToDo notes: If another project member has created or commented on ToDo notes in Trimble Connector, the ToDos are automatically synchronized immediately. Alternatively, you can click the synchronize button to synchronize the ToDos immediately.
• Adjust ToDo settings: Click the Settings button. The settings affect the snapshots view.

1.17 Applications & components catalog and component improvements

Tekla Structures 2017 introduces the following improvements in the Applications & components catalog and components.

Change the order of groups in the Applications & components catalog
You can now change the order of the predefined groups in the Applications & components catalog.
You can control the order of the groups with a sort index that is available for each predefined group.

You can change the sort index by entering either a negative or a positive integer, or 0, in the **Sort index** option box. A negative sort index moves a group towards the top and a positive sort index moves a group towards the bottom in the predefined groups section. Enter 0 or clear the value to revert to the default order. By default, the groups are in alphabetical order. Sort indexes are saved in the catalog definition files.

**Concrete components**

**Wall layout tools**

Wall layout tools support the design process from conceptual design to detailing wall structures. You can use the tools to:

1. Build a shape.
2. Build a shape and create openings.
3. Create wall type definitions.
4. Create wall elementation and define detailed wall geometry.
5. Define detailed connections, openings, embeds, and reinforcement.
Wall layout tools is a set of components that you can use for creating and modifying all common types of concrete walls, such as solid precast panels from single layers to double walls and sandwich walls, and different wall structures that are cast on the site. The wall structure may contain several layers, such as, structural layers, insulation, void, and surface treatment. You can use direct modification to flexibly change the wall geometry, layer offsets, openings and seam lines.

Wall layout tools are available in the Applications & components catalog.

Detailing manager
Detailing manager is used to apply detailing components to any structure. With Detailing manager you can define rules to apply multiple components at one go to detail the structure of a cast unit or the entire model.

Documentation updates for custom components
The documentation for the custom components functionality have been updated with new images and more detailed step-by-step instructions. Please note that the functionality itself has not been changed.

The instructions in the Add variables to a custom component section have been revised with many new images that help guide the reader. To complement the instructions, a couple of completely new help topics have been added. As requested by some of our readers, we have also included two alternative ways of modifying custom component dialog boxes: by using the graphical user interface and by editing the input files manually in a text editor.

1.18 New template attributes
Tekla Structures 2017 introduces some new features and improvements in templates and reports, including new attributes for getting information on drawings marked ready for issuing, and new attributes for reinforcement.

New attributes for getting information on marked ready for issuing status

**IS_READY_FOR_ISSUE**
The IS_READY_FOR_ISSUE attribute tells if the drawing has been marked ready for issuing in the Drawing list. This attribute can be used for adding information about drawings marked for issuing in drawing reports. The report returns the value 1 if the drawing is marked ready for issuing, and 0 if it is not marked ready for issuing.
The Drawing list has a column Ready for issuing for this information. If the
drawing has been marked, there is a check mark in the column.

To include in the report who has marked the drawing ready for issuing, use the
attribute READY_FOR_ISSUE_BY.

### READY_FOR_ISSUE_BY

The READY_FOR_ISSUE_BY attribute tells who has marked a drawing ready for
issuing. This attribute can be used for adding information about who marked
the drawing ready for issuing in drawing reports. The Drawing list has a
column Ready for issuing by for this information.

To include in a report whether the drawing has been marked ready for issuing,
use the attribute IS_READY_FOR_ISSUE.

### New attributes for reinforcement

The new attributes USAGE and USAGE_VALUE show if a reinforcing bar is a
main bar, or a tie or stirrup.

The USAGE attribute returns Main bar for main bars, and Tie or stirrup
for ties and stirrups. If the type of use cannot be defined, the USAGE attribute
returns a blank value.

The USAGE_VALUE attribute returns 1 for main bars, and 2 for ties and
stirrups. If the type of use cannot be defined, the USAGE_VALUE attribute
returns 0.

## 1.19 New and deleted advanced options

Some advanced options have been added and changed in and deleted from
Tekla Structures.

### New advanced options

#### XS_MODEL_BACKUP_DIRECTORY

You can now define a folder for the backup copies of Tekla Structures model
files. The default value is ..\TeklaStructuresModels\backup\.

#### XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS

Now you can also refresh locked reference models with the Refresh button

To do this, set the new advanced option

XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS to TRUE in File --> Settings
Advanced options. This system-specific option is by default set to FALSE.

**XS_REPORT_BOLTS_WITH_SUPPORTING_MEMBER**

You can now set the site bolts to the supporting member in reports and KSS by setting the new user-specific advanced option `XS_REPORT_BOLTS_WITH_SUPPORTING_MEMBER` to TRUE in File --> Settings --> Advanced options --> Templates and Symbols. With this new advanced option you can now show the field bolts in the BOM of the supporting member. The default value is FALSE.

**Examples**

In the following BOM example, the advanced option is set to TRUE:

```
ONE - COLUMN - C2

BILL OF MATERIAL

<table>
<thead>
<tr>
<th>MARK</th>
<th>QTY</th>
<th>DESCRIPTION</th>
<th>LENGTH</th>
<th>WEIGHT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>C2</td>
<td>1</td>
<td>COLUMN</td>
<td></td>
<td></td>
<td>SQ-2</td>
</tr>
<tr>
<td>C2</td>
<td>1</td>
<td>W16X89</td>
<td>21-11 1/4&quot;</td>
<td>1956</td>
<td>A992</td>
</tr>
<tr>
<td>BP2</td>
<td>1</td>
<td>PL3/4&quot;X26&quot;</td>
<td>2-2&quot;</td>
<td>144</td>
<td>A36</td>
</tr>
<tr>
<td>p7</td>
<td>1</td>
<td>FL3/8&quot;X3 1/2&quot;</td>
<td>1-0&quot;</td>
<td>4</td>
<td>A36</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>3/4&quot;Ø A325N BOLT</td>
<td>0-2&quot;</td>
<td></td>
<td>Site</td>
</tr>
</tbody>
</table>

TOTAL WEIGHT THIS DRAWING 2104
```

In the following BOM example, the advanced option is set to FALSE:

```
ONE - COLUMN - C2

BILL OF MATERIAL

<table>
<thead>
<tr>
<th>MARK</th>
<th>QTY</th>
<th>DESCRIPTION</th>
<th>LENGTH</th>
<th>WEIGHT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>C2</td>
<td>1</td>
<td>COLUMN</td>
<td></td>
<td></td>
<td>SQ-2</td>
</tr>
<tr>
<td>C2</td>
<td>1</td>
<td>W16X89</td>
<td>21-11 1/4&quot;</td>
<td>1956</td>
<td>A992</td>
</tr>
<tr>
<td>BP2</td>
<td>1</td>
<td>PL3/4&quot;X26&quot;</td>
<td>2-2&quot;</td>
<td>144</td>
<td>A36</td>
</tr>
<tr>
<td>p7</td>
<td>1</td>
<td>FL3/8&quot;X3 1/2&quot;</td>
<td>1-0&quot;</td>
<td>4</td>
<td>A36</td>
</tr>
</tbody>
</table>

TOTAL WEIGHT THIS DRAWING 2104
```

In the following KSS file example, the advanced option is set to TRUE:
In the following KSS file example, the advanced option is set to FALSE:
XS_REBARSET_COLOR_BARGROUPS

Set the new model-specific advanced option XS_REBARSET_COLOR_BARGROUPS to TRUE in File --> Settings --> Advanced options --> Concrete Detailing to show reinforcing bars in different automatic bar groups within a rebar set using different colors in model views. The default value is FALSE.

Deleted advanced options

XS_ENABLE_AUTODRAWINGS_IN_MENU

The advanced option XS_ENABLE_AUTODRAWINGS_IN_MENU is no longer needed, and has been removed. It used to add the AutoDrawings command on the Tekla Structures menu in some earlier Tekla Structures versions. The AutoDrawings command is now available through Quick Launch. When you enter the command, the AutoDrawings dialog box is displayed.
XS_AD_PLATE_MESH_CHECK_DISTANCE_LIMIT and
XS_AD_PLATE_MESH_CHECK_PART_ID

The advanced options XS_AD_PLATE_MESH_CHECK_DISTANCE_LIMIT and
XS_AD_PLATE_MESH_CHECK_PART_ID have been removed from Tekla
Structures.
© 2017 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Trimble does not guarantee that the text is free of technical inaccuracies or typographical errors. Trimble reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the United States, and/or other countries. More about Trimble Solutions trademarks: http://www.tekla.com/tekla trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Trimble does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.
EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights reserved.
Open Cascade Express Mesh © 2015 OPEN CASCADE S.A.S. All rights reserved.
PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.
FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.
Teigha © 2002-2016 Open Design Alliance. All rights reserved.
CADhatch.com © 2017. All rights reserved.
FlexNet Publisher © 2014 Flexera Software LLC. All rights reserved.
This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.
To see the third party open source software licenses, go to Tekla Structures, click File menu --> Help --> About Tekla Structures and then click the 3rd party licenses option.
The elements of the software described in this Manual are protected by several patents and possibly pending patent applications in the United States and/or other countries. For more information go to page http://www.tekla.com/tekla-patents.